Chapter 396

GEE Tests for the TAD of Two Groups in a Repeated Measures Design (Continuous Outcome)

Introduction

This module calculates the power for testing the time-averaged difference (TAD) between two means from continuous, correlated data that are analyzed using the GEE method. Such data occur in two design types: clustered and longitudinal.

GEE is different from MM in that it does not require the full specification of the joint distribution of the repeated measurements, as long as the marginal mean model is correctly specified. Estimation consistency is achieved even if the correlation matrix is incorrect. Also, the correlation matrix of the responses is specified directly, rather than using an intermediate, random effects model as is the case in MM. For clustered designs, GEE often uses a compound symmetric (CS) correlation structure. For longitudinal data, an autoregressive (AR(1)) correlation structure is often used.

Time-averaged difference analysis is often used when the outcome to be measured varies with time. For example, suppose that you want to compare two treatment groups based on the means of a certain outcome such as blood pressure. It is known that a person's blood pressure depends on several instantaneous factors such as amount of sleep, excitement level, mood, exercise, etc. If only a single measurement is taken from each patient then the comparison of mean values from the two groups may be invalid because of the large degree of variation in blood pressure levels among patients. The precision of the experiment is increased by taking multiple measurements from each individual and comparing the time-averaged difference between the two groups. Care must be taken in the analysis because of the correlation that is introduced when several measurements are taken from the same individual. The correlation structure may take on several forms depending on the nature of the experiment and the subjects involved.

Missing Values

This procedure allows you to specify various patterns of incomplete (or missing) data. Subjects may miss some appointments, but attend others. This phenomenon of incomplete data can be accounted for in the sample size calculation which can greatly reduce the overall sample size from that calculated by just omitting subjects with incomplete observations.
Technical Details

Theory and Notation

Technical details are given in Ahn, Heo, and Zhang (2015), chapter 4, section 4.4.1, pages 110-116.

Suppose we have \( n_1 \) subjects in group 1 (treatment) and \( n_2 \) subjects in group 2 (control) for a total of \( N \) subjects, each measured on \( M \) occasions at times \( t_j (j = 1, \ldots, M) \). For convenience, we normalize these time points to the proportion of total time so that \( t_1 = 0 \) and \( t_M = 1 \). The mean of \( y_j \) is modeled by

\[
\mu_{ij} = \beta_1 + \beta_2 r_i
\]

where

- \( y_{ij} \) is the \( j \)th response from subject \( i \), with variance given by \( \sigma^2 \).
- \( \mu_{ij} \) is expectation of \( y_{ij} \).
- \( r_i \) is the subject treatment indicator with 0 for control and 1 for treatment,
- \( \beta_1 \) is the regression coefficient giving intercept of the control group,
- \( \beta_2 \) is the regression coefficient giving the TAD between the two groups.

In this procedure, the primary interest is on \( \beta_2 \).

This mean model is reparametrized as

\[
\mu_{ij} = b_1 + b_2 (r_i - \bar{r})
\]

where

\[
\begin{align*}
 b_1 &= \beta_1 + \bar{r} \beta_2 \\
 b_2 &= \beta_2
\end{align*}
\]

The vector of covariates is given by \( x_{ij} = (1, r_i - \bar{r})' \).

GEE is used to estimate and test hypotheses about \( b \) with \( \hat{b} \).

Correlation Patterns

In a longitudinal design with \( N \) subjects, each measured \( M \) times, observations from a single subject are correlated, and a pattern of those correlations through time needs to be specified. Several choices are available.

Compound Symmetry

A compound symmetry covariance model assumes that all covariances are equal, and all variances on the diagonal are equal. That is

\[
\rho_{jj'} = \begin{bmatrix}
1 & \rho & \rho & \cdots & \rho \\
\rho & 1 & \rho & \cdots & \rho \\
\rho & \rho & 1 & \cdots & \rho \\
\vdots & \vdots & \vdots & \ddots & \vdots \\
\rho & \rho & \rho & \cdots & 1
\end{bmatrix}_{M \times M}
\]

where \( \rho \) is the baseline correlation.
Banded(1)
A Banded(1) (banded order 1) correlation model assumes that all variances on the diagonal are equal, covariances for observations one time period apart are equal to $\rho$, and covariances for measurements greater than one time period apart are equal to zero. That is

$$[p_{jj'}] = \begin{bmatrix} 1 & \rho & 0 & 0 & \cdots & 0 \\ \rho & 1 & \rho & 0 & \cdots & 0 \\ 0 & \rho & 1 & \rho & \cdots & 0 \\ 0 & 0 & \rho & 1 & \cdots & 0 \\ \vdots & \vdots & \vdots & \vdots & \ddots & \vdots \\ 0 & 0 & 0 & 0 & \cdots & 1 \end{bmatrix}_{M \times M}$$

where $\rho$ is the baseline correlation.

Banded(2)
A Banded(2) (banded order 2) correlation model assumes that all variances on the diagonal are equal, covariances for observations one time period or two periods apart are equal to $\rho$, and covariances for measurements greater than one time period apart are equal to zero. That is

$$[p_{jj'}] = \begin{bmatrix} 1 & \rho & \rho & 0 & \cdots & 0 \\ \rho & 1 & \rho & \rho & \cdots & 0 \\ \rho & \rho & 1 & \rho & \cdots & 0 \\ 0 & \rho & \rho & 1 & \cdots & 0 \\ \vdots & \vdots & \vdots & \vdots & \ddots & \vdots \\ 0 & 0 & 0 & 0 & \cdots & 1 \end{bmatrix}_{M \times M}$$

where $\rho$ is the baseline correlation.

AR1 (Traditional)
This version of AR1 (autoregressive order 1) correlation model assumes that all variances on the diagonal are equal and that correlations $t$ time periods apart are equal to $\rho^t$. That is

$$[p_{jj'}] = \begin{bmatrix} 1 & \rho & \rho^2 & \rho^3 & \cdots & \rho^{M-1} \\ \rho & 1 & \rho & \rho^2 & \cdots & \rho^{M-2} \\ \rho^2 & \rho & 1 & \rho & \cdots & \rho^{M-3} \\ \rho^3 & \rho^2 & \rho & 1 & \cdots & \rho^{M-4} \\ \vdots & \vdots & \vdots & \vdots & \ddots & \vdots \\ \rho^{M-1} & \rho^{M-2} & \rho^{M-3} & \rho^{M-4} & \cdots & 1 \end{bmatrix}_{M \times M}$$

where $\rho$ is the baseline correlation.

AR1 (Proportional)
This version of AR1 (autoregressive order 1) correlation model is described in the book by Ahn et al. (2015). It assumes that all variances on the diagonal are equal and that correlations $|t_j - t_k|$ time periods apart are equal to $\rho^{|t_j - t_k|}$. That is

$$[p_{jk}] = \left[\rho^{|t_j - t_k|}\right]_{M \times M}$$

where $\rho$ is the baseline correlation. Note that in this pattern, the value of $\rho$ is shown in the final column since in this case $t_j = 0$ and $t_k = 1$, so $|t_j - t_k| = 1$.
Dampened Exponential

A dampened exponential is an extension of the AR(1) correlation model in which the exponents are raised to the power $D_{exp}$ ($\theta = D_{exp}$ in the diagram below). This causes the resulting correlations to be reduced (dampened). Here is an example

$$
\begin{bmatrix}
1 & \rho & \rho^2 \theta & \rho^3 \theta & \ldots & \rho^{(M-1)} \theta \\
\rho & 1 & \rho & \rho^2 \theta & \ldots & \rho^{(M-2)} \theta \\
\rho^2 \theta & \rho & 1 & \rho & \ldots & \rho^{(M-3)} \theta \\
\vdots & \vdots & \vdots & \vdots & \ddots & \vdots \\
\rho^{(M-1)} \theta & \rho^{(M-2)} \theta & \rho^{(M-3)} \theta & \rho^{(M-4)} \theta & \ldots & 1
\end{bmatrix}_{M \times M}
$$

where $\rho$ is the baseline correlation.

Dampened Exponential (Proportional)

This version of the dampened exponential correlation model is described in the book by Ahn et al. (2015). It assumes that all variances on the diagonal are equal and that correlations $|t_j - t_k|$ time periods apart are equal to $\rho^{|t_j - t_k| \theta}$. That is

$$
[\rho_{jk}] = [\rho^{|t_j - t_k| \theta}]_{M \times M}
$$

where $\rho$ is the baseline correlation. Note that in this pattern, the value of $\rho^{|t_j - t_k| \theta}$ turns up in the final column since in this case $t_j = 0$ and $t_k = 1$, so $|t_j - t_k| = 1$.

Linear Exponential Decay

A linear exponential decay correlation model is one in which the exponent of the correlation decays according to a linear equation from 1 at the Base Time Proportion to a final value, $E_{max}$. The resulting pattern looks similar to the dampened exponential. Note that the exponents are applied to the absolute difference between the Measurement Time Proportions. This method allows you to easily construct comparable correlation matrices of different dimensions. Otherwise, differences in the resulting power would be more strongly due to differences in the correlation matrices.

Here is an example. Suppose $m$ is 6, $\rho = 0.5$, $E_{max} = 3$, the Base Time Proportion is 0.20, and the Measurement Time Proportions are (0, 0.2, 0.4, 0.6, 0.8, 1). The following correlation matrix would be obtained

$$
[\rho_{jj'}] = 
\begin{bmatrix}
1 & 0.5 & 0.3536 & 0.25 & 0.1768 & 0.125 \\
0.5 & 1 & 0.5 & 0.3536 & 0.25 & 0.1768 \\
0.3536 & 0.5 & 1 & 0.5 & 0.3536 & 0.25 \\
0.25 & 0.3536 & 0.5 & 1 & 0.5 & 0.3536 \\
0.1768 & 0.25 & 0.3536 & 0.5 & 0.3536 & 0.5 \\
0.125 & 0.1768 & 0.25 & 0.3536 & 0.5 & 1
\end{bmatrix}_{M \times M}
$$

Note that in the top row, the correlation is 0.5 for the second (0.2 - 0) time point and 0.125 (0.5^3) at the last (1 - 0) time points. The correlations are obtained by raising 0.5 to the appropriate exponent. The linear equation from 1 to 3 results in the exponents 1, 1.5, 2, 2.5, 3 correspondent to the time proportions 0, 0.2, 0.4, 0.6, 0.8, and 1.

As a further example, note that the correlation for the 0.4 time point is, $0.5^{1.5} = 0.35355339 \approx 0.3536$. 

396-4
This method allows you to compare various values of $M$ while keeping the correlation matrix similar. To see what we mean, consider what the correlation matrix looks like when $M$ is reduced to 4 and the measurement time proportions are set to $(0, 0.2, 0.6, 1)$. It becomes

$$[ho_{jj'}] = \begin{bmatrix}
1 & 0.5 & 0.25 & 0.125 \\
0.5 & 1 & 0.5 & 0.25 \\
0.25 & 0.5 & 1 & 0.5 \\
0.125 & 0.25 & 0.5 & 1
\end{bmatrix}_{M \times M}$$

Note that the correlation at a measurement time difference of 0.6 is equal to 0.25 in both matrices.

**Missing Data Patterns**

The problem of missing data occurs for several reasons. In longitudinal studies in which a subject is measured multiple times, missing data becomes more complicated to model because it is possible that a subject is measured only some of the time. In fact, it is probably more common for data to be incomplete than complete. The approach of omitting subjects with incomplete data during the planning phase is very inaccurate. Certainly, subjects with partial measurements are included in the analysis. This procedure provides several missing data patterns to choose from so that your sample size calculations are more realistic.

In the presentation to following, we denote the percent of subjects with a missing response at time point $t_j$ as $\kappa_j$. The proportion non-missing at a particular time point is $\phi_j = 1 - \kappa_j$. We will refer to $\phi_j$ as the *marginal observant probability* at time $t_j$ and $\phi_{jj'}$ as a *joint observant probability* at times $t_j$ and $t_{j'}$.

**Pairwise Missing Pattern**

The program provides three options for how the pairwise (joint) observant probabilities $\phi_{jj'}$ are calculated. These are

- **Independent (Ind):** $\phi_{jj'} = \phi_j \phi_{j'}$, $\phi_{jj} = \phi_j$
- **Monotonic (Mon):** $\phi_{jj'} = \phi_k$ where $k = \max(j, j')$
- **Mixture:** $\phi_{jj'} = W(\text{Ind}) + (1 - W)(\text{Mon})$ for weighting factor $W$.

**Missing Input Type**

There are several ways in which the missing value pattern can be specified. Each missing value pattern is a list of missing proportions at each of the $M$ time points. Each value in the list must be non-negative and less than 1. Possible input choices are

- **Constant = 0**
  All missing proportions are set to 0. That is, there are no missing values.

- **Constant**
  All missing proportions are set to constant value.

- **Piecewise Constant on Spreadsheet**
  A set of missing proportions are defined for several time intervals using the spreadsheet. One column contains the missing proportions for the interval, going down the rows. Another column defines the corresponding upper limit of time proportion of the interval. The lower limit is implied by the limit given immediately above. The program assumes that the first time interval starts at 0 percent.
• **Linear (Steady Change)**
  The missing proportions fall along a straight-line between 0 and 1 elapsed time. Only the first and last proportions are entered.

• **Piecewise Linear on Spreadsheet**
  The missing proportions fall along a set of connected straight-lines that are defined by two columns on the spreadsheet.

• **List**
  Enter a list of M missing proportions, one for each time point.

• **Multiple Lists on Spreadsheet**
  Select multiple columns containing vertical lists of missing proportions. Each column contains a set of missing proportions in rows, one for each time point.

• **Pairwise Observed Proportions on Spreadsheet**
  Enter an $M \times M$ matrix of observant probabilities by selecting M columns. These observant probabilities are the proportion of the responses for both the row and column time points that are observed.

---

**Sample Size Calculations**

The details of the calculation of sample size and power is given in Ahn, Heo, and Zhang (2015), Chapter 4. These are summarized here.

As explained above, GEE is used to estimate the regression coefficients $b$ with $\hat{\beta}$. The significance of $b_4$, the coefficient associated with the difference between the control and treatment slopes, is tested using a Wald statistic from which the following sample size formula is derived

$$ n = \frac{\sigma^2 \eta_0 \left( z_{1-\gamma} + z_{1-\gamma} \right)^2}{\delta^2 \mu_0^2 \sigma_r^2} $$

where

- $h = 1$ (one-sided test) or 2 (two-sided test)
- $\gamma = 1 - \text{power}$
- $\alpha = \text{significance level}$
- $\delta = \beta_2$

$$ \mu_0 = \sum_{j=1}^{M} \phi_j $$

$$ \eta_0 = \sum_{j=1}^{M} \sum_{j'=1}^{M} \phi_{jj'} \rho_{jj'} $$

$$ \sigma_r^2 = \bar{r}(1 - \bar{r}) $$

$$ \phi_j = 1 - \kappa_j, \text{ where } \kappa_j = \text{proportion missing at the } j^{\text{th}} \text{ time point} $$

$\rho_{jj'}$ is the corresponding element from within-subject correlation matrix

$\phi_{jj'}$ is the joint observant probability of observing both $y_{ij}$ and $y_{ij'}$ for every subject $i$
Three possible choices are available to calculate $\phi_{jj'}$. These are

- Independent: $\phi_{jj'} = \phi_j \phi_{j'}$, $\phi_{jj} = \phi_j$
- Monotonic: $\phi_{jj'} = \phi_k$ where $k = \max(j, j')$
- Mixture: $\phi_{jj'} = W(\text{Independent}) + (1 - W)(\text{Monotonic})$ for weighting factor $W$.

The above formula is easily rearranged to obtain a formula for power.

**Procedure Options**

This section describes the options that are specific to this procedure. These are located on the Design tab. For more information about the options of other tabs, go to the Procedure Window chapter.

**Design Tab**

The Design tab contains most of the parameters and options that you will be concerned with.

**Solve For**

This option specifies the parameter to be solved for. When you choose to solve for Sample Size, the program searches for the lowest sample size that meets the alpha and power criterion you have specified. The Solve For parameter is displayed on the vertical axis of the plot.

**Test**

**Alternative Hypothesis**

This option specifies the alternative hypothesis. The null hypothesis is always $H_0: \delta = 0$

Note that the alternative hypothesis enters into power calculations by specifying the rejection region of the hypothesis test. Its accuracy is critical.

Possible selections are:

- **One-Sided**
  This option yields a *one-tailed* test. Use it for testing the alternative hypotheses $H_1: \delta < 0$ or $H_1: \delta > 0$.

- **Two-Sided**
  This is the most common selection. Use it for testing the alternative hypotheses $H_1: 0 \neq \delta$.

**Power and Alpha**

**Power**

This option specifies one or more values for power. Power is the probability of rejecting a false null hypothesis, and is equal to one minus Beta. Beta is the probability of a type-II error, which occurs when a false null hypothesis is not rejected. In this procedure, a type-II error occurs when you fail to reject the null hypothesis of equal slopes when in fact the slopes are different.
Values must be between zero and one. Historically, the value of 0.80 (beta = 0.20) was used for power. Now, 0.90 (beta = 0.10) is also commonly used.

A single value may be entered here or a range of values such as 0.8 to 0.95 by 0.05 may be entered.

**Alpha**
This option specifies one or more values for the probability of a type-I error. A type-I error occurs when a true null hypothesis is rejected. In this procedure, a type-I error occurs when you reject the null hypothesis of equal slopes when in fact the slopes are equal.

Values must be between zero and one. Historically, the value of 0.05 has been used for alpha. This means that about one test in twenty will falsely reject the null hypothesis. You should pick a value for alpha that represents the risk of a type-I error you are willing to take in your experimental situation.

You may enter a range of values such as 0.01 0.05 0.10 or 0.01 to 0.10 by 0.01.

---

**Sample Size and Group 1 Allocation Percentage**

**N (Subjects)**
Enter a value for the sample size, N, the number of subjects in the study. Each subject is measured $M$ times, where $M > 1$.

You may enter a single value, such as ‘42’; a range of values, such as ‘10 to 100 by 10’; or a list of values, such as ‘10 30 80 90’.

**R (Group 1 Allocation %)**
Enter one or more values for the percentage of the subjects that are (or will be) in group 1, the treatment group. The usual entry is 50 for 50%. The valid range is from 1 to 99. However, a more reasonable range is from 10 to 90. Usually, the treatment group allocation is 50%.

You can enter a single value such as ‘50’ or a series of values such as ‘40 50 60’ or ‘40 to 70 by 5’.

---

**Measurement Times Schedule**

**Measurement Time Input Type**
Specify how you want to enter the information about the measurement proportion times.

- **Equally Spaced Measurement Times**
  Enter one or more values for $M$, the number of measurements per subject. Equally-spaced measurement time proportions will automatically be generated.

- **List of Measurement Time Proportions**
  Enter a list of measurement time proportions in the box below, one for each time point. The number of measurement times, $M$, is set equal to the number of items in this list.

- **Columns of Measurement Time Proportions**
  Select one or more columns of the spreadsheet that contain a set of measurement time proportions. Each column is analyzed separately. The number of measurement times, $M$, is equal to the number of rows in the active column.
M (Measurements)
Specify one or more values for $M$, the total number of measurements scheduled for each subject. It is assumed that these measurements are made at identical time points or under the same conditions.

At least one value must be entered. If multiple values are entered, a separate analysis is run for each value.

The value must be an integer greater than 1. A reasonable range is from 2 to 50.

Some examples are

3
3 4 5
3 to 10 by 1

Measurement Time Proportions
Enter a set of measurement time proportions, one for each time point. The number of measurements, $M$, is the number of items in the list. Each entry in the list is the proportion that that time is of the maximum time.

For example, suppose a 24-month study is planned with anticipated measurements at the beginning and then after each six-month period. Hence, the five measurement times are 0, 6, 12, 18, and 24 months. The entry must be proportions of 24, so the actual entry would be ‘0, 0.25, 0.50, 0.75, 1.0’.

$M$, the number of repeated measurements, is set to the number of items in the list.

Once $M$ is set here, it must match its implicit value in the Correlations and Missing Proportions.

Auto Rescaling
You can enter any increasing series that is convenient and it will be rescaled so that each entry is a proportion of the maximum. In the example above, you could have entered ‘0, 6, 12, 18, 24’ or even ‘1, 2, 3, 4, 5’ and the program would have rescaled the values into proportions beginning at 0 and ending at 1.

Valid Entries
Since the numbers are automatically rescaled, the only requirement is that the series be strictly increasing.

Examples

0 0.25 0.50 0.75 1.0
0 1 0.5 0.9 1.0
0 0.20 0.40 0.90 0.95 1.0
1 2 3 4 5
0 1 2 3 4

Column(s) of Time Proportions
Enter one or more spreadsheet columns containing lists of measurement time proportions.

Press the Spreadsheet icon (directly to the right) to select the columns and then enter the values. Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Also note that you can obtain the spreadsheet by selecting Tools, then Input Spreadsheet, from the menus. On the spreadsheet, the measurement times are entered going down.
Examples
C1  C2  C3
0.0  1  0.1
0.2  2  0.4
0.4  3  0.5
0.6  4  
0.8
1.0

Definition of a Single Column
Each column gives one list of time proportions. Each column results in a new scenario. Different columns are not connected and may be of different lengths.

Each entry in the list is the proportion that that time is of the maximum time. For example, suppose a 24-month study is planned with anticipated measurements at the beginning and then after each six-month period. Hence, the five measurement times are 0, 6, 12, 18, and 24 months. The entry must be proportions of 24, so the actual entry would be ’0, 0.25, 0.50, 0.75, 1.0’ (entered vertically in a particular column).

Auto Rescaling
You can enter any increasing series that is convenient and it will be rescaled so that each entry is a proportion of the maximum. In the example above, you could have entered ’0 6 12 18 24’, or even ’1 2 3 4 5’, going down the column and the program would have rescaled the values into proportions beginning at 0 and ending at 1.

Valid Entries
Since the numbers are automatically rescaled, the only requirement is that the series be strictly increasing.

Notes
M, the number of repeated measurements, is set to the number of items in the active column.

Once M is set here, it must match its implicit value in the Correlations and Missing Proportions.

The column names (C1, C2, ...) can be changed by clicking on them in the spreadsheet.

Effect Size
δ (Time-Averaged Difference)
Enter a value (or range of values) for the difference in time-averaged responses (TAD) between two treatment groups that you want to be able to detect. Note that this value is in the same scale as σ.

Testing the TAD is used when the impact of a treatment is quick and then stays near a certain value.

These values must be positive.

You can enter a single value such as ‘10’, a series of values such as ‘10 20 30 40 50’, or ‘1 to 5 by 0.5’.

σ (Standard Deviation)
Enter a value (or range of values) for the standard deviation of the response, \( Y_{ij} \) where \( i \) is the subject and \( j \) is the repeated measurement of that subject. The analysis assumes that this standard deviation is constant across all subjects.

These values must be positive.

You can enter a single value such as ‘10’ or a series of values such as ‘10 20 30 40 50’ or ‘1 to 5 by 0.5’.
Effect Size - $\rho$ (Correlation Between Measurements)

Pattern of $\rho$'s Across Time (or Space)
Specify the type of pattern for the $\rho$'s, the correlations between responses of an individual at two points in time or between subjects within a cluster. This pattern often depends on the measurement time proportions. Usually, the correlation shrinks as two points are further and further apart in time. The options are

- **Compound Symmetry (All $\rho$'s Equal)**
  A single value of $\rho$ is used for all correlations. This pattern is commonly used for cluster-randomized trials in which case $m$ is the cluster size and $\rho$ is the intracluster correlation.

  \[
  \begin{pmatrix}
  1 & \rho & \rho & \rho \\
  \rho & 1 & \rho & \rho \\
  \rho & \rho & 1 & \rho \\
  \rho & \rho & \rho & 1 \\
  \end{pmatrix}
  \]

  Example first row of correlation matrix
  1.0000, 0.5000, 0.5000, 0.5000, 0.5000

- **Banded (1 Time Period)**
  This is similar to all $\rho$'s equal, except that all elements are set to zero after the first off-diagonal element.

  \[
  \begin{pmatrix}
  1 & \rho & 0 & 0 \\
  \rho & 1 & \rho & 0 \\
  0 & \rho & 1 & \rho \\
  0 & 0 & \rho & 1 \\
  \end{pmatrix}
  \]

  Example first row of correlation matrix
  1.0000, 0.5000, 0.0000, 0.0000, 0.0000, 0.0000

- **Banded (2 Time Periods)**
  This is similar to all $\rho$'s equal, except that all elements are set to zero after the second off-diagonal element.

  \[
  \begin{pmatrix}
  1 & \rho & \rho & 0 \\
  \rho & 1 & \rho & \rho \\
  \rho & \rho & 1 & \rho \\
  0 & \rho & \rho & 1 \\
  \end{pmatrix}
  \]

  Example first row of correlation matrix
  1.0000, 0.5000, 0.5000, 0.0000, 0.0000, 0.0000

- **AR1 (Traditional) 1st Order Autocorrelation**
  A single value of $\rho$ is used to generate a first order autocorrelation pattern in the correlation matrix. This pattern produces the autocorrelation at each successive step by multiplying the value at the last step by $\rho$. The basic formula is $\rho_{jk} = \rho^{j-k}$. Thus the pattern is $\rho$, $\rho^2$, $\rho^3$, etc.

  \[
  \begin{pmatrix}
  1 & \rho & \rho^2 & \rho^3 \\
  \rho & 1 & \rho & \rho^2 \\
  \rho^2 & \rho & 1 & \rho \\
  \rho^3 & \rho^2 & \rho & 1 \\
  \end{pmatrix}
  \]

  Example first row of correlation matrix
  1.0000, 0.5000, 0.2500, 0.1250, 0.0625, 0.0313
• **AR1 (Proportional)**
A single value of $\rho$ is used to generate a first order autocorrelation pattern in the correlation matrix. This pattern produces the autocorrelation at each successive step by multiplying the value at the last step by $\rho$. The basic formula is $p_{jk} = \rho^{|t_j-t_k|}$, where $t_j$ and $t_k$ are time proportions at which measurements are planned. An example is

\[
\begin{array}{cccc}
\rho^{0} & \rho^{1} & \rho^{2} & \rho^{3} \\
\rho^{1} & \rho^{0} & \rho^{1} & \rho^{2} \\
\rho^{2} & \rho^{1} & \rho^{0} & \rho^{1} \\
\rho^{3} & \rho^{2} & \rho^{1} & \rho^{0} \\
\end{array}
\]

Example first row of correlation matrix when $M = 6$ and $\rho = 0.1$. Note that $\rho$ shows up at the end of the list in this case.

1.0000, 0.6310, 0.3981, 0.2512, 0.1585, 0.1000

• **Dampened Exponential (Traditional)**
This pattern is similar to the AR(1), except that the exponents are raised to the power of a second parameter which we label as Dexp. The formula is $p_{jk} = \rho^{|j-k|^Dexp}$.

Example first row of correlation matrix with Dexp = 1.1

1.0000, 0.5000, 0.2012, 0.0729, 0.0245, 0.0078

• **Dampened Exponential (Proportional)**
A single value of $\rho$ is used to generate a first order autocorrelation pattern in the correlation matrix. This pattern produces the autocorrelation at each successive step by multiplying the value at the last step by $\rho$. The basic formula is $p_{jk} = \rho^{|t_j-t_k|^Dexp}$, where $t_j$ and $t_k$ are time proportions at which measurements are planned. An example with Dexp = 1 is

\[
\begin{array}{cccc}
\rho^{0} & \rho^{1} & \rho^{2} & \rho^{3} \\
\rho^{1} & \rho^{0} & \rho^{1} & \rho^{2} \\
\rho^{2} & \rho^{1} & \rho^{0} & \rho^{1} \\
\rho^{3} & \rho^{2} & \rho^{1} & \rho^{0} \\
\end{array}
\]

Example first row of correlation matrix when $M = 6$, $\rho = 0.1$, and Dexp = 1. Note that $\rho$ shows up at the end of the list in this case.

1.0000, 0.6310, 0.3981, 0.2512, 0.1585, 0.1000

• **Linear Exponential Decay**
This pattern is similar to AR(1). The formula is $p_{jk} = \rho^{|t_j-t_k|/P}*E_{max}$. P is called the Base Time Proportion. The exponents of $\rho$ range from 1 at $P$ to $E_{max}$ at $M$.

Example first row of correlation matrix with $E_{max} = 4$

1.0000, 0.5000, 0.2973, 0.1768, 0.1051, 0.0625

This pattern is particularly useful when you want to compare different values of $M$ since the exponent only depends on the difference. That is, a difference of 0.10 in the time proportions will always result in the same exponent, no matter what the value of $M$. This is NOT the case for AR(1).

• **Matrix on Spreadsheet**
A symmetric matrix is entered in the spreadsheet. The number of columns selected must match $M$, the number of time periods.
\( \rho \) Pattern = Compound Symmetry, Banded (1 Time Period), Banded (2 Time Periods), AR(1)

\( \rho \) (Base Correlation)
This is the base correlation, \( \rho \), between measurements on the same subject taken at two time points. In several cases, this value is modified according to a special formula.

At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.

**Range**
0 < \( \rho \) < 1 (negative values are not used). A value near 0 indicates low correlation. A value near 1 indicates high correlation.

**Recommended**
The value of this parameter depends on time or location pattern at which measurements are taken. In their book on sample size, Machin and Campbell comment that values between 0.60 and 0.75 are typical. Some authors recommend using 0.2 when nothing is known about the actual value.

**Examples**
0.5
0.5 0.6 0.7
0 to 0.9 by 0.1

\( \rho \) Pattern = Damped Exponential

\( \rho \) (Base Correlation)
This is the base correlation, \( \rho \), between measurements on the same subject taken at two time points. In several cases, this value is modified according to a special formula.

At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.

**Range**
0 < \( \rho \) < 1 (negative values are not used). A value near 0 indicates low correlation. A value near 1 indicates high correlation.

**Recommended**
The value of this parameter depends on time or location pattern at which measurements are taken. In their book on sample size, Machin and Campbell comment that values between 0.60 and 0.75 are typical. Some authors recommend using 0.2 when nothing is known about the actual value.

**Examples**
0.5
0.5 0.6 0.7
0 to 0.9 by 0.1

**Dexp (Dampening Exponent)**
This exponent is applied to the AR(1) formula so that the resulting correlations are reduced faster. The formula become \( \rho_{jk} = \rho^{\left|j-k\right| Dexp} \).

**Range**
The valid range is \( Dexp > 0 \). The typical range is 1 to 3.
\( \rho \) Pattern = Linear Exponential Decay

\( \rho \) (Base Correlation)
This is the base correlation, \( \rho \), between measurements on the same subject taken at two time points. In several cases, this value is modified according to a special formula.

At least one value must be entered. If multiple values are entered, a separate analysis is performed for each value.

Range
\( 0 < \rho < 1 \) (negative values are not used). A value near 0 indicates low correlation. A value near 1 indicates high correlation.

Recommended
The value of this parameter depends on time or location pattern at which measurements are taken. In their book on sample size, Machin and Campbell comment that values between 0.60 and 0.75 are typical. Some authors recommend using 0.2 when nothing is known about the actual value.

Examples
0.5
0.5 0.6 0.7
0 to 0.9 by 0.1

Base Time Proportion
The base time proportion is used by the Linear Exponential Decay formula to specify the time proportion at which the correlation exponent is one. Thus, at this proportion the base correlation is reproduced.

Range
\( 0 < \text{Time} < 0.5 \).

Typical Value
\( 1/M \)

Note
When you are comparing values of \( M \), choose a value for \( M \) near the smallest value of \( 1/M \).

Emax (Max Decay Exponent)
This specifies the exponent of the base correlation when the time proportion is 1. Thus, the exponents go linearly from 1 at the base time to Emax at the maximum time.

Range
Emax > 0.

Typical
Typical values of Emax are between 1 and 10.
**p Pattern = Matrix on Spreadsheet**

**Columns Containing the pjk's**
Select a set of M columns from the spreadsheet that contain a correlation matrix. Each column represents a column of the correlation matrix so it must contain M rows.

Since this is a correlation matrix, the diagonal elements must be set to one and the absolute values of the off-diagonal elements must be less than one. Also, the matrix must be symmetric.

---

**Missing Proportions Across Measurement Times**

**Missing Input Type**
Specify the way in which you want to specify the pattern of missing values.

Each missing value pattern is a list of missing proportions at each of the M time points. Each value in the list must be non-negative and less than 1.

Possible input choices are

- **Constant = 0**
  All missing proportions are set to 0. That is, there are no missing values.

- **Constant**
  All missing proportions are set to constant value.

- **Piecewise Constant on Spreadsheet**
  A set of missing proportions are defined for several time intervals using the spreadsheet. One column contains the missing proportions for the interval, going down the rows. Another column defines the corresponding upper limit of time proportion of the interval. The lower limit is implied by the limit given immediately above. The program assumes that the first time interval starts at 0 percent.

- **Linear (Steady Change)**
  The missing proportions fall along a straight-line between 0 and 1 elapsed time. Only the first and last proportions are entered.

- **Piecewise Linear on Spreadsheet**
  The missing proportions fall along a set of connected straight-lines that are defined by two columns on the spreadsheet.

- **List**
  Enter a list of M missing proportions, one for each time point.

- **Multiple Lists on Spreadsheet**
  Select multiple columns containing vertical lists of missing proportions. Each column contains a set of missing proportions in rows, one for each time point.

- **Pairwise Observed Proportions on Spreadsheet**
  Enter an M x M matrix of observant probabilities by selecting M columns. These observant probabilities are the proportion of the responses for both the row and column time points that are observed
**Missing Input Type = Constant Additional Options**

**Constant Missing Proportion**
Enter one or more values of the missing value proportion that is to be used for all time points.
If multiple values are entered, a separate analysis is performed for each value.

**Range**
\[0 \leq \text{Missing Proportion} < 1.\]

**Examples**
- 0.2
- 0.1 0.2 0.4
- 0 to 0.4 by 0.1

**Missing Input Type = Piecewise Constant on Spreadsheet Additional Options**

**Pairwise Missing Pattern**
See the Pairwise Missing Pattern section of above.

**Column of Missing Proportions (Pairwise)**
Enter the column name on the spreadsheet containing a column of missing proportions, one for each segment. The program assigns this missing proportion to all time points in this time segment. The number of segments is arbitrary and determined by the number of rows.

Note that the usual pattern is to have the missing proportions increase over time.

Press the Spreadsheet icon (directly to the right) to select the column and then enter the missing proportion values.

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Note that you can obtain also the spreadsheet window by selecting "Tools", then "Input Spreadsheet", from the menus.

(Pairwise)
This refers to the two types of pairwise missing patterns: Ind(ependent) and Mon(otonic).

**Example**
Suppose that 'C1' is selected for the Missing column and 'C2' is selected for the Time column. Suppose that these columns contain the following values:

<table>
<thead>
<tr>
<th>C1</th>
<th>C2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>0.2</td>
</tr>
<tr>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>0.35</td>
<td>0.75</td>
</tr>
<tr>
<td>0.4</td>
<td>0.9</td>
</tr>
<tr>
<td>0.6</td>
<td>1.0</td>
</tr>
</tbody>
</table>

This would be interpreted by the program as

<table>
<thead>
<tr>
<th>Time Interval</th>
<th>Missing</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 \leq t \leq 0.2</td>
<td>0.1</td>
</tr>
<tr>
<td>0.2 &lt; t \leq 0.5</td>
<td>0.3</td>
</tr>
<tr>
<td>0.5 &lt; t \leq 0.75</td>
<td>0.35</td>
</tr>
<tr>
<td>0.75 &lt; t \leq 0.9</td>
<td>0.4</td>
</tr>
<tr>
<td>0.9 &lt; t \leq 1.0</td>
<td>0.6</td>
</tr>
</tbody>
</table>
Column of Time Proportions (Pairwise)
Enter the column name on the spreadsheet containing a column of Upper Limit Time Proportions, one for each segment. The program assigns the missing proportion to all time points in the time segment defined by this upper limit. The number of segments is arbitrary and determined by the number of rows. Note that the final upper limit must be 1.

Press the Spreadsheet icon (directly to the right) to select the column and then enter the missing proportion values.

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Note that you can obtain also the spreadsheet window by selecting "Tools", then "Input Spreadsheet", from the menus.

(Pairwise)
This refers to the two types of pairwise missing patterns: Ind(ependent) and Mon(otonic).

Example
Suppose that 'C1' is selected for the Missing column and 'C2' is selected for the Time column. Suppose that these columns contain the following values:

<table>
<thead>
<tr>
<th>C1</th>
<th>C2</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.1</td>
<td>0.2</td>
</tr>
<tr>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>0.35</td>
<td>0.75</td>
</tr>
<tr>
<td>0.4</td>
<td>0.9</td>
</tr>
<tr>
<td>0.6</td>
<td>1.0</td>
</tr>
</tbody>
</table>

This would be interpreted by the program as

<table>
<thead>
<tr>
<th>Time Interval</th>
<th>Missing</th>
</tr>
</thead>
<tbody>
<tr>
<td>0 ≤ t ≤ 0.2</td>
<td>0.1</td>
</tr>
<tr>
<td>0.2 &lt; t ≤ 0.5</td>
<td>0.3</td>
</tr>
<tr>
<td>0.5 &lt; t ≤ 0.75</td>
<td>0.35</td>
</tr>
<tr>
<td>0.75 &lt; t ≤ 0.9</td>
<td>0.4</td>
</tr>
<tr>
<td>0.9 &lt; t ≤ 1.0</td>
<td>0.6</td>
</tr>
</tbody>
</table>

**Missing Input Type = Linear (Steady Change) Additional Options**

**Pairwise Missing Pattern**
See the Pairwise Missing Pattern section of above.

**First (or Last) Missing Proportion (Pairwise)**
Specify a set of \( M \) missing proportions by entering only the first and last values of the list. A straight-line formula will be used to calculate the missing proportions for each time point in the interval.

**Range**
\[ 0 \leq \text{First} \leq \text{Last} \]
First ≤ Last < 1

**Example**
Suppose a study is being planned with 5, evenly spaced, measurements. Further suppose that the missing data proportions are anticipated to be 0.1 initially and increase to 0.6 at the end of the study, with the missing proportions in between arranged linearly. If \( M = 5 \), First = 0.1, and Last = 0.6, then the resulting Missing Proportions will be 0.1, 0.225, 0.35, 0.475, and 0.60. Note that these proportions are evenly spaced between the two boundaries.
Note that using this option allows the value of $M$ to be varied and reasonable comparisons in power and sample size to be made.

**Missing Input Type = Piecewise Linear on Spreadsheet Additional Options**

**Pairwise Missing Pairwise**
See the Pairwise Missing Pairwise section of above.

**Column of Missing (or Time) Proportions (Pairwise)**
These options let you easily define separate missing proportions for various time intervals of a study.

Select the column name on the spreadsheet of a column containing missing proportions. Also select the column name of the corresponding measurement time proportions. The program calculates a straight-line defined by each successive pair of points (see example below). This set of connected line segments becomes a prediction equation for the missing proportion based on the corresponding time proportion.

The number of line segments is arbitrary and determined from the number of rows in the selected columns. The number of rows does not have to match $M$, the number of time points.

(Pairwise)
This designates which of the two types of pairwise missing patterns, Ind(ependent) or Mon(otonic), is being entered in this option.

**Notes**
The usual pattern is to for the missing proportions to increase over time. The time value of the first row of the time column must be 0. The time value of the last row of the time column must be 1.

**Shortcuts**
Press the Spreadsheet icon (directly to the right) to select the column and then enter the missing proportion values. Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Note that you can obtain also the spreadsheet window by selecting "Tools", then "Input Spreadsheet", from the menus.

**Example**
Suppose that you have enter data in two columns on the spreadsheet labeled Miss and Time as follows.

<table>
<thead>
<tr>
<th>Miss</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5</td>
<td>0</td>
</tr>
<tr>
<td>0.1</td>
<td>0.2</td>
</tr>
<tr>
<td>0.3</td>
<td>0.5</td>
</tr>
<tr>
<td>0.35</td>
<td>0.75</td>
</tr>
<tr>
<td>0.4</td>
<td>0.9</td>
</tr>
<tr>
<td>0.6</td>
<td>1</td>
</tr>
</tbody>
</table>

Now suppose that Miss is selected for the Missing column and Time is selected for the Time column. This would be interpreted by the program as the following segmented-prediction equation.

<table>
<thead>
<tr>
<th>Time Interval</th>
<th>Slope</th>
<th>Intercept</th>
</tr>
</thead>
<tbody>
<tr>
<td>$0 \leq T \leq 0.2$</td>
<td>$(0.1-0.05)/(0.2-0)$</td>
<td>$0.1-0.2*0.25 = 0.05$</td>
</tr>
<tr>
<td>$0.2 &lt; T \leq 0.5$</td>
<td>$(0.3-0.1)/(0.5-0.2)$</td>
<td>$0.3-0.5*0.67 = -0.0333$</td>
</tr>
<tr>
<td>$0.5 &lt; T \leq 0.75$</td>
<td>$(0.35-0.3)/(0.75-0.5)$</td>
<td>$0.35-0.75*0.2 = 0.2$</td>
</tr>
<tr>
<td>$0.75 &lt; T \leq 0.9$</td>
<td>$(0.4-0.35)/(0.9-0.75)$</td>
<td>$0.4-0.9*0.33 = 0.1$</td>
</tr>
<tr>
<td>$0.9 &lt; T \leq 1$</td>
<td>$(0.6-0.4)/(1-0.9)$</td>
<td>$0.6-1*2 = -1.4$</td>
</tr>
</tbody>
</table>
A Missing Proportion would then be calculated using the formula

\[
\text{Missing} = \text{Intercept} + \text{Slope} \times \text{Time}
\]

For example, using the above values, the missing proportions at time points 0, 0.1, 0.3, 0.8, and 1.0 would be found as follows:

<table>
<thead>
<tr>
<th>Time</th>
<th>Equation</th>
<th>Resulting Missing Proportion</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0.05 + 0.25(0)</td>
<td>0.05</td>
</tr>
<tr>
<td>0.1</td>
<td>0.05 + 0.25(0.1)</td>
<td>0.075</td>
</tr>
<tr>
<td>0.3</td>
<td>-0.0333 + 0.67(0.3)</td>
<td>0.1667</td>
</tr>
<tr>
<td>0.8</td>
<td>0.1 + 0.33(0.8)</td>
<td>0.3667</td>
</tr>
<tr>
<td>1.0</td>
<td>-1.4 + 2(1)</td>
<td>0.6</td>
</tr>
</tbody>
</table>

**Missing Input Type = List Additional Options**

**Pairwise Missing Pairwise**

See the Pairwise Missing Pairwise section of above.

**List of Missing Proportions (Pairwise)**

These options let you easily define separate missing proportions for various time intervals of a study.

Select the column name on the spreadsheet of a column containing missing proportions. Also select the column name of the corresponding measurement time proportions. The program calculates a straight-line defined by each successive pair of points (see example below). This set of connected line segments becomes a prediction equation for the missing proportion based on the corresponding time proportion.

**Missing Input Type = Multiple Lists on Spreadsheet Additional Options**

**Pairwise Missing Pairwise**

See the Pairwise Missing Pairwise section of above.

**Columns of Missing Proportions (Pairwise)**

Enter lists of missing value proportions by first entering them on the spreadsheet and then selecting those columns here. The missing value proportions are entered down the rows of a column, one for each time point. Each value is the anticipated proportion of missing responses at the corresponding time point.

Although you can enter any pattern you want, the usual pattern is that the proportion missing increases over time.

When you specify more than \( M \) values in a list (where \( M \) is specified in the Measurement Times section), the extra values are ignored. When you specify too few values, the last value you specify is copied forward.

Press the Spreadsheet icon (directly to the right) to select the column and then enter the missing proportion values.

Press the Input Spreadsheet icon (to the right and slightly up) to view/edit the spreadsheet. Note that you can obtain also the spreadsheet window by selecting "Tools", then "Input Spreadsheet", from the menus.

**Pairwise**

This designates which of the two types of pairwise missing patterns, Ind(ependent) or Mon(otonic), is being entered in this option.

**Range**

\[ 0 \leq \text{missing proportion} < 1. \]
Columns of Pairwise Observed

Enter an M-by-M matrix of pairwise observed proportions on the spreadsheet and then select it by selecting those M columns here. Each entry gives the proportion (or probability) that the corresponding row and column time point values are both observed (non-missing). The diagonal elements of this matrix contain the probability that an observation is observed at that point (marginal probability).

Range

0 < each value ≤ 1.

Note

In other missing entries, you enter the proportion missing. This is the only case that requires the proportion observed.
Example 1 – Determining Sample Size

Researchers are planning a study of the impact of a new drug on heart rate. They want to evaluate the change in heart rate between subjects who take the new drug, and subjects who take the standard drug. Their experimental protocol calls for the administration of a certain level of the drug, followed by three measurements 2 days apart. They want to be able to detect a TAD of 5 between the two groups. They want a sensitivity analysis by considering a range of differences from 3 to 8.

Similar studies have found a standard deviation of 9.2 of the residuals within a subject across time. These studies also showed an autocorrelation between adjacent measurements on the same individual of 0.7, so they want to try values of 0.6, 0.7, and 0.8. The researchers assume that first-order autocorrelation adequately represents the autocorrelation pattern. The two-sided test will be conducted at the 0.05 significance level and at 90% power. They are planning on dividing the subjects equally between the treatment and control groups.

The researchers anticipate that the missing pattern across time will begin at 0% missing and increase steadily to 30% at the third measurement. They assume that the pairwise missing is independent.

What are the sample size requirements for this study?

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the GEE Tests for the TAD of Two Groups in a Repeated Measures Design (Continuous Outcome) procedure window. You may then make the appropriate entries as listed below, or open Example 1 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>R (Group 1 Allocation %)</td>
<td>50</td>
</tr>
<tr>
<td>Measurement Time Input Type</td>
<td>Equally Spaced Measurement Times</td>
</tr>
<tr>
<td>M (Number of Measurement Times)</td>
<td>3</td>
</tr>
<tr>
<td>δ (Time-Averaged Difference)</td>
<td>3 4 5 6 7 8</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>9.2</td>
</tr>
<tr>
<td>Pattern of ρ’s Across Time</td>
<td>AR1 (Traditional)</td>
</tr>
<tr>
<td>ρ (Base Correlation)</td>
<td>0.6, 0.7, 0.8</td>
</tr>
<tr>
<td>Missing Input Type</td>
<td>Linear (Steady Change)</td>
</tr>
<tr>
<td>Pairwise Missing Pattern</td>
<td>Independent (Ind)</td>
</tr>
<tr>
<td>First Missing Proportion (Ind)</td>
<td>0</td>
</tr>
<tr>
<td>Last Missing Proportion (Ind)</td>
<td>0.30</td>
</tr>
</tbody>
</table>
## Annotated Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results for a Time-Averaged Difference Test using GEE

<table>
<thead>
<tr>
<th>Power</th>
<th>Group 1 Alloc N</th>
<th>Allocated Pct</th>
<th>Times M</th>
<th>TAD δ</th>
<th>Std Dev σ</th>
<th>Base Corr ρ</th>
<th>First Row of Corr Matrix</th>
<th>Alpha</th>
<th>Missing</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9009</td>
<td>292</td>
<td>50.0</td>
<td>3</td>
<td>3.00</td>
<td>9.20</td>
<td>0.6000</td>
<td>p1(T1) 0.050</td>
<td>M1(T1)</td>
<td>T1</td>
<td></td>
</tr>
<tr>
<td>0.9003</td>
<td>320</td>
<td>50.0</td>
<td>3</td>
<td>3.00</td>
<td>9.20</td>
<td>0.7000</td>
<td>p2(T1) 0.050</td>
<td>M1(T1)</td>
<td>T1</td>
<td></td>
</tr>
<tr>
<td>0.9008</td>
<td>351</td>
<td>50.0</td>
<td>3</td>
<td>3.00</td>
<td>9.20</td>
<td>0.8000</td>
<td>p3(T1) 0.050</td>
<td>M1(T1)</td>
<td>T1</td>
<td></td>
</tr>
<tr>
<td>0.9005</td>
<td>164</td>
<td>50.0</td>
<td>3</td>
<td>4.00</td>
<td>9.20</td>
<td>0.6000</td>
<td>p1(T1) 0.050</td>
<td>M1(T1)</td>
<td>T1</td>
<td></td>
</tr>
<tr>
<td>0.9003</td>
<td>180</td>
<td>50.0</td>
<td>3</td>
<td>4.00</td>
<td>9.20</td>
<td>0.7000</td>
<td>p2(T1) 0.050</td>
<td>M1(T1)</td>
<td>T1</td>
<td></td>
</tr>
<tr>
<td>0.9002</td>
<td>197</td>
<td>50.0</td>
<td>3</td>
<td>4.00</td>
<td>9.20</td>
<td>0.8000</td>
<td>p3(T1) 0.050</td>
<td>M1(T1)</td>
<td>T1</td>
<td></td>
</tr>
<tr>
<td>0.9006</td>
<td>105</td>
<td>50.0</td>
<td>3</td>
<td>5.00</td>
<td>9.20</td>
<td>0.6000</td>
<td>p1(T1) 0.050</td>
<td>M1(T1)</td>
<td>T1</td>
<td></td>
</tr>
<tr>
<td>0.9022</td>
<td>116</td>
<td>50.0</td>
<td>3</td>
<td>5.00</td>
<td>9.20</td>
<td>0.7000</td>
<td>p2(T1) 0.050</td>
<td>M1(T1)</td>
<td>T1</td>
<td></td>
</tr>
</tbody>
</table>

### Footnotes

- **T1**: 0.00, 0.50, 1.00
- **M1(T1)**: 0.00, 0.15, 0.30
- **p1(T1)**: 1.0000, 0.6000, 0.3600
- **p2(T1)**: 1.0000, 0.7000, 0.4900
- **p3(T1)**: 1.0000, 0.8000, 0.6400

### References


### Summary Statements

A sample of 292 subjects, each measured 3 times, achieve a power of 0.9009 when using a two-sided Wald test from a GEE analysis to test whether the time-average difference of the treatment subjects differs from that of the control subjects by more than 3.00 at a significance level of 0.050. The subjects are randomly split between a treatment group and a control group, with 50.0% of the subjects assigned to the treatment group. The residual standard deviation is anticipated to be 9.20. The measurements of each subject will be made at the following times expressed as proportions of the total study time: {0.00, 0.50, 1.00}.

Missing values are assumed to occur completely at random (MCAR). These missing value proportions will be combined to form the pairwise observant probabilities using the Independent method. The anticipated proportions missing at each measurement time are {0.00, 0.15, 0.30}.

The first row of the autocorrelation matrix of the responses within a subject is assumed to be {1.0000, 0.6000, 0.3600}. Other rows follow the same pattern.

This report gives the sample size for each value of the other parameters.
Power
This is the power actually achieved for the computed sample size. It is not exactly 0.90 because the sample size was rounded to an integer.

\( N \)
The total number of subjects.

\( R \)
This is the percent of the \( N \) subjects allocated to the treatment group.

\( M \) (Times)
This is the number of repeated measurements taken.

\( \delta \) (TAD)
This is the time-average difference in mean response at which the power is calculated. It is in the same scale as \( \sigma \).

\( \sigma \) (Standard Deviation)
This is standard deviation of a response.

\( \rho \) (Base Correlation)
\( \rho \) is the base correlation between two responses on the same subject. It may be transformed in the correlation matrix based on the correlation pattern (which was AR(1) in this example).

First Row of Corr Matrix
This is the footnote name of this row in the Footnotes. The corresponding footnote gives the values of the first row in the correlation matrix.

Alpha
Alpha is the significance level of the test.

Missing
This is the footnote name of this row in the Footnotes. The corresponding footnote gives the values of the missing proportions across time.

Time
This is the footnote name of this row in the Footnotes. The corresponding footnote gives the values of the measurement time proportions at each of the four measurement points.
These charts show the relationship between sample size, $\delta$, and $\rho$ when the other parameters in the design are held constant.

**Autocorrelation Matrix for Report Row 1**

<table>
<thead>
<tr>
<th>Time</th>
<th>T(0.00)</th>
<th>T(0.50)</th>
<th>T(1.00)</th>
</tr>
</thead>
<tbody>
<tr>
<td>T(0.00)</td>
<td>1.0000</td>
<td>0.6000</td>
<td>0.3600</td>
</tr>
<tr>
<td>T(0.50)</td>
<td>0.6000</td>
<td>1.0000</td>
<td>0.6000</td>
</tr>
<tr>
<td>T(1.00)</td>
<td>0.3600</td>
<td>0.6000</td>
<td>1.0000</td>
</tr>
</tbody>
</table>

These reports show the autocorrelation matrix for the indicated row of the report.
Example 2 – Finding the Power

Continuing with Example 1, the researchers want to determine the power corresponding to sample sizes ranging from 50 to 250 for the main cases of the other parameters.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the **GEE Tests for the TAD of Two Groups in a Repeated Measures Design (Continuous Outcome)** procedure window. You may then make the appropriate entries as listed below, or open Example 2 by going to the **File** menu and choosing **Open Example Template**.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Tab</strong></td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N (Subjects)</td>
<td>50 to 250 by 50</td>
</tr>
<tr>
<td>R (Group 1 Allocation %)</td>
<td>50</td>
</tr>
<tr>
<td>Measurement Time Input Type</td>
<td>Equally Spaced Measurement Times</td>
</tr>
<tr>
<td>M (Number of Measurement Times)</td>
<td>3</td>
</tr>
<tr>
<td>δ (Time-Averaged Difference)</td>
<td>5</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>9.2</td>
</tr>
<tr>
<td>Pattern of ρ’s Across Time</td>
<td>AR1 (Traditional)</td>
</tr>
<tr>
<td>ρ (Base Correlation)</td>
<td>0.7</td>
</tr>
<tr>
<td>Missing Input Type</td>
<td>Linear (Steady Change)</td>
</tr>
<tr>
<td>Pairwise Missing Pattern</td>
<td>Independent</td>
</tr>
<tr>
<td>First Missing Proportion (Ind)</td>
<td>0</td>
</tr>
<tr>
<td>Last Missing Proportion (Ind)</td>
<td>0.30</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results for a Time-Averaged Difference Test using GEE
Measurement Times: Equally spaced
Correlation: AR(1): \( p(j,k) = p^{|j-k|} \)
Missing Pattern: Range of missing proportions
Observant Proportions: Assume independence

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>Pct Times</th>
<th>TAD</th>
<th>Std Dev</th>
<th>Base Corr</th>
<th>First Row of Corr</th>
<th>Alpha</th>
<th>Missing</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5701</td>
<td>50</td>
<td>50.0</td>
<td>3</td>
<td>5.00</td>
<td>9.20</td>
<td>( p(T1) )</td>
<td>0.050</td>
<td>M1(T1)</td>
<td>T1</td>
</tr>
<tr>
<td>0.8558</td>
<td>100</td>
<td>50.0</td>
<td>3</td>
<td>5.00</td>
<td>9.20</td>
<td>( p(T1) )</td>
<td>0.050</td>
<td>M1(T1)</td>
<td>T1</td>
</tr>
<tr>
<td>0.9591</td>
<td>150</td>
<td>50.0</td>
<td>3</td>
<td>5.00</td>
<td>9.20</td>
<td>( p(T1) )</td>
<td>0.050</td>
<td>M1(T1)</td>
<td>T1</td>
</tr>
<tr>
<td>0.9966</td>
<td>200</td>
<td>50.0</td>
<td>3</td>
<td>5.00</td>
<td>9.20</td>
<td>( p(T1) )</td>
<td>0.050</td>
<td>M1(T1)</td>
<td>T1</td>
</tr>
<tr>
<td>0.9976</td>
<td>250</td>
<td>50.0</td>
<td>3</td>
<td>5.00</td>
<td>9.20</td>
<td>( p(T1) )</td>
<td>0.050</td>
<td>M1(T1)</td>
<td>T1</td>
</tr>
</tbody>
</table>

The reports and plot indicate the power for each value of N.
Example 3 – Impact of the Number of Repeated Measurements

Continuing with Examples 1 and 2, the researchers want to study the impact on the sample size of changing the number of measurements made on each individual. Their experimental protocol calls for 3 measurements that are 2 days apart. They want to see the impact on sample size of taking measurements daily. To do this, they will need to increase the number of measurements to 5.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the GEE Tests for the TAD of Two Groups in a Repeated Measures Design (Continuous Outcome) procedure window. You may then make the appropriate entries as listed below, or open Example 3 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N (Subjects)</td>
<td>50 to 250 by 50</td>
</tr>
<tr>
<td>R (Group 1 Allocation %)</td>
<td>50</td>
</tr>
<tr>
<td>Measurement Time Input Type</td>
<td>Equally Spaced Measurement Times</td>
</tr>
<tr>
<td>M (Number of Measurement Times)</td>
<td>3, 5</td>
</tr>
<tr>
<td>δ (Time-Averaged Difference)</td>
<td>5</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>9.2</td>
</tr>
<tr>
<td>Pattern of ρ’s Across Time</td>
<td>AR1 (Traditional)</td>
</tr>
<tr>
<td>ρ (Base Correlation)</td>
<td>0.7</td>
</tr>
<tr>
<td>Missing Input Type</td>
<td>Linear (Steady Change)</td>
</tr>
<tr>
<td>Pairwise Missing Pattern</td>
<td>Independent</td>
</tr>
<tr>
<td>First Missing Proportion (Ind)</td>
<td>0</td>
</tr>
<tr>
<td>Last Missing Proportion (Ind)</td>
<td>0.30</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>Pct</th>
<th>Times</th>
<th>TAD</th>
<th>Std Dev</th>
<th>Base Corr p</th>
<th>First Row of Corr Matrix</th>
<th>Alpha</th>
<th>Missing</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.5701</td>
<td>50</td>
<td>50.0</td>
<td>3</td>
<td>5.00</td>
<td>9.20</td>
<td>0.7000</td>
<td>p1(T1) 0.050 M1(T1)</td>
<td>0.050</td>
<td></td>
<td>T1</td>
</tr>
<tr>
<td>0.6633</td>
<td>50</td>
<td>50.0</td>
<td>5</td>
<td>5.00</td>
<td>9.20</td>
<td>0.7000</td>
<td>p1(T1) 0.050 M1(T2)</td>
<td>0.050</td>
<td>T1</td>
<td>T2</td>
</tr>
<tr>
<td>0.8558</td>
<td>100</td>
<td>50.0</td>
<td>3</td>
<td>5.00</td>
<td>9.20</td>
<td>0.7000</td>
<td>p1(T1) 0.050 M1(T1)</td>
<td>0.050</td>
<td>T1</td>
<td>T1</td>
</tr>
<tr>
<td>0.9204</td>
<td>100</td>
<td>50.0</td>
<td>5</td>
<td>5.00</td>
<td>9.20</td>
<td>0.7000</td>
<td>p1(T1) 0.050 M1(T2)</td>
<td>0.050</td>
<td>T1</td>
<td>T2</td>
</tr>
<tr>
<td>0.9591</td>
<td>150</td>
<td>50.0</td>
<td>3</td>
<td>5.00</td>
<td>9.20</td>
<td>0.7000</td>
<td>p1(T1) 0.050 M1(T1)</td>
<td>0.050</td>
<td>T1</td>
<td>T1</td>
</tr>
<tr>
<td>0.9548</td>
<td>150</td>
<td>50.0</td>
<td>5</td>
<td>5.00</td>
<td>9.20</td>
<td>0.7000</td>
<td>p1(T1) 0.050 M1(T2)</td>
<td>0.050</td>
<td>T1</td>
<td>T2</td>
</tr>
<tr>
<td>0.9996</td>
<td>200</td>
<td>50.0</td>
<td>3</td>
<td>5.00</td>
<td>9.20</td>
<td>0.7000</td>
<td>p1(T1) 0.050 M1(T1)</td>
<td>0.050</td>
<td>T1</td>
<td>T1</td>
</tr>
<tr>
<td>0.9976</td>
<td>200</td>
<td>50.0</td>
<td>5</td>
<td>5.00</td>
<td>9.20</td>
<td>0.7000</td>
<td>p1(T1) 0.050 M1(T2)</td>
<td>0.050</td>
<td>T1</td>
<td>T2</td>
</tr>
<tr>
<td>0.9976</td>
<td>250</td>
<td>50.0</td>
<td>3</td>
<td>5.00</td>
<td>9.20</td>
<td>0.7000</td>
<td>p1(T1) 0.050 M1(T1)</td>
<td>0.050</td>
<td>T1</td>
<td>T1</td>
</tr>
<tr>
<td>0.9996</td>
<td>250</td>
<td>50.0</td>
<td>5</td>
<td>5.00</td>
<td>9.20</td>
<td>0.7000</td>
<td>p1(T1) 0.050 M1(T2)</td>
<td>0.050</td>
<td>T1</td>
<td>T2</td>
</tr>
</tbody>
</table>

Footnotes

T1: 0.00, 0.50, 1.00
T2: 0.00, 0.25, 0.50, 0.75, 1.00
M1(T1): 0.00, 0.15, 0.30
M1(T2): 0.00, 0.08, 0.15, 0.23, 0.30
ρ1(T1): 1.0000, 0.7000, 0.4900
ρ1(T2): 1.0000, 0.7000, 0.4900, 0.3430, 0.2401

Note that increasing the number of measurements has had the result of increasing power.
Example 4 – Validation of Sample Size Calculation using Ahn, Heo, and Zhang (2015)

Ahn, Heo, and Zhang (2015) do not present any numerical examples for this procedure. However, on page 115 they give a simplified formula for the compound symmetry case. We will calculate a result by hand using this formula and then calculate with the program to validate this procedure.

The simplified sample size formula is

\[
n = \frac{4\sigma^2[1 + (m - 1)\rho]\left(z_{1-\alpha} + z_{1-\gamma}\right)^2}{\delta^2m}
\]

Using \( m = 5, \sigma = 3, \rho = 0.5, \delta = 1.5, \alpha = 0.05, \) and power = 0.9, we obtain

\[
n = \text{ceiling}\left(\frac{4(3^2)[1 + (5 - 1)0.5](1.96 + 1.28)^2}{1.5^2(5)}\right)
\]

\[
= \text{ceiling}(100.78)
\]

\[
= 101
\]

Setup

This section presents the values of each of the parameters needed to generate the upper-left-quarter of this example. First, from the PASS Home window, load the GEE Tests for the TAD of Two Groups in a Repeated Measures Design (Continuous Outcome) procedure window. You may then make the appropriate entries as listed below, or open Example 4 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Sample Size</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Power</td>
<td>0.90</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>R (Group 1 Allocation %)</td>
<td>50</td>
</tr>
<tr>
<td>Measurement Time Input Type</td>
<td>Equally Spaced Measurement Times</td>
</tr>
<tr>
<td>M (Number of Measurement Times)</td>
<td>5</td>
</tr>
<tr>
<td>( \delta ) (Time-Averaged Difference)</td>
<td>1.5</td>
</tr>
<tr>
<td>( \sigma ) (Standard Deviation)</td>
<td>3</td>
</tr>
<tr>
<td>Pattern of ( \rho )'s Across Time</td>
<td>Compound Symmetry</td>
</tr>
<tr>
<td>( \rho ) (Base Correlation)</td>
<td>0.5</td>
</tr>
<tr>
<td>Missing Input Type</td>
<td>Constant = 0</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>Pct</th>
<th>Times</th>
<th>TAD</th>
<th>Std Dev</th>
<th>Base Corr</th>
<th>Missing</th>
<th>Corr</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9004</td>
<td>101</td>
<td>50.0</td>
<td>5</td>
<td>1.50</td>
<td>3.00</td>
<td>0.5000</td>
<td>0.00</td>
<td>0.00</td>
<td>T1</td>
</tr>
</tbody>
</table>

Footnotes
- T1: 0.00, 0.25, 0.50, 0.75, 1.00
- p1(T1): 1.0000, 0.5000, 0.5000, 0.5000, 0.5000

The sample size is 101, which matches Ahn, Heo, and Zhang (2015) exactly.
Example 5 – Impact of Measurement Time Distribution

This example will investigate the impact of measurement time on power. It will compare the power of studies that are evenly spaced with those that take more measurements at the beginning of the study, near the middle of the study, and at the end of the study.

In this example the standard deviation is 28, the TAD is 10, the significance level is 0.05, the sample size ranges from 70 to 150, and R is 50%. The correlation pattern will be Linear Exponential Decay with a base correlation of 0.8, Base Time Proportion of 0.20, and $E_{\text{max}}$ set to 4. The missing input type will be set to Linear from 0 to 30% and the pairwise missing assumption will be independent.

The measurement times for five scenarios are given in the following table.

<table>
<thead>
<tr>
<th>Tm1</th>
<th>Tm2</th>
<th>Tm3</th>
<th>Tm4</th>
<th>Tm5</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.00</td>
<td>0.00</td>
<td>0.10</td>
<td>0.10</td>
<td>0.45</td>
</tr>
<tr>
<td>0.20</td>
<td>0.60</td>
<td>0.10</td>
<td>0.00</td>
<td>0.45</td>
</tr>
<tr>
<td>0.40</td>
<td>0.70</td>
<td>0.20</td>
<td>0.20</td>
<td>0.50</td>
</tr>
<tr>
<td>0.60</td>
<td>0.80</td>
<td>0.30</td>
<td>0.80</td>
<td>0.55</td>
</tr>
<tr>
<td>0.80</td>
<td>0.90</td>
<td>0.40</td>
<td>0.90</td>
<td>0.60</td>
</tr>
<tr>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
<td>1.00</td>
</tr>
</tbody>
</table>

Note that the measurements in Tm1 are evenly spaced, those in Tm2 are loaded near the end, those of Tm3 occur at the beginning, those of Tm4 occur only at the beginning and the end, and those of Tm5 occur mostly near the middle.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the GEE Tests for the TAD of Two Groups in a Repeated Measures Design (Continuous Outcome) procedure window. You may then make the appropriate entries as listed below, or open Example 5 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N (Subjects)</td>
<td>70, 100, 150</td>
</tr>
<tr>
<td>R (Group 1 Allocation %)</td>
<td>50</td>
</tr>
<tr>
<td>Measurement Time Input Type</td>
<td>Columns of Measurement Time Proportions</td>
</tr>
<tr>
<td>Column(s) of Time Proportions</td>
<td>Tm1-Tm5</td>
</tr>
<tr>
<td>The above table must be entered into the spreadsheet and the column names changed to Tm1 – Tm5. Press the Input Spreadsheet icon to the right to view the spreadsheet.</td>
<td></td>
</tr>
<tr>
<td>$\delta$ (Time-Averaged Difference)</td>
<td>10</td>
</tr>
<tr>
<td>$\sigma$ (Standard Deviation)</td>
<td>28</td>
</tr>
<tr>
<td>Pattern of $\rho$’s Across Time</td>
<td>Linear Exponential Decay</td>
</tr>
<tr>
<td>$\rho$ (Base Correlation)</td>
<td>0.8</td>
</tr>
<tr>
<td>Base Time Proportion</td>
<td>0.2</td>
</tr>
<tr>
<td>$E_{\text{max}}$ (Max Decay Exponent)</td>
<td>4</td>
</tr>
<tr>
<td>Missing Input Type</td>
<td>Linear (Steady Change)</td>
</tr>
<tr>
<td>Pairwise Missing Pattern</td>
<td>Independent (Ind)</td>
</tr>
<tr>
<td>First Missing Proportion (Ind)</td>
<td>0</td>
</tr>
<tr>
<td>Last Missing Proportion (Ind)</td>
<td>0.3</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

<table>
<thead>
<tr>
<th>Group 1 Alloc</th>
<th>Power</th>
<th>Times</th>
<th>TAD δ</th>
<th>Std Dev</th>
<th>Base Corr p</th>
<th>First Row of Corr Matrix</th>
<th>Alpha</th>
<th>Missing</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power N R Pct Times</td>
<td>0.4116 70 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm1) 0.050 M1(Tm1)</td>
<td>Tm1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.3974 70 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm2) 0.050 M1(Tm2)</td>
<td>Tm2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.3938 70 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm3) 0.050 M1(Tm3)</td>
<td>Tm3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.4199 70 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm4) 0.050 M1(Tm4)</td>
<td>Tm4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.3906 70 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm5) 0.050 M1(Tm5)</td>
<td>Tm5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.5460 100 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm1) 0.050 M1(Tm1)</td>
<td>Tm1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.5286 100 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm2) 0.050 M1(Tm2)</td>
<td>Tm2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.5242 100 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm3) 0.050 M1(Tm3)</td>
<td>Tm3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.5561 100 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm4) 0.050 M1(Tm4)</td>
<td>Tm4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.5202 100 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm5) 0.050 M1(Tm5)</td>
<td>Tm5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.7197 150 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm1) 0.050 M1(Tm1)</td>
<td>Tm1</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.7014 150 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm2) 0.050 M1(Tm2)</td>
<td>Tm2</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.6967 150 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm3) 0.050 M1(Tm3)</td>
<td>Tm3</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.7302 150 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm4) 0.050 M1(Tm4)</td>
<td>Tm4</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.6924 150 50.0 6 10.00 28.00</td>
<td>0.8000 p1(Tm5) 0.050 M1(Tm5)</td>
<td>Tm5</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Footnotes

Tm1: 0.00, 0.20, 0.40, 0.60, 0.80, 1.00
Tm2: 0.00, 0.60, 0.70, 0.80, 0.90, 1.00
Tm3: 0.00, 0.10, 0.20, 0.30, 0.40, 1.00
Tm4: 0.00, 0.10, 0.20, 0.80, 0.90, 1.00
Tm5: 0.00, 0.45, 0.50, 0.55, 0.60, 1.00
M1(Tm1): 0.00, 0.06, 0.12, 0.18, 0.24, 0.30
M1(Tm2): 0.00, 0.18, 0.21, 0.24, 0.27, 0.30
M1(Tm3): 0.00, 0.03, 0.06, 0.09, 0.12, 0.30
M1(Tm4): 0.00, 0.03, 0.06, 0.24, 0.27, 0.30
M1(Tm5): 0.00, 0.14, 0.15, 0.17, 0.18, 0.30
p1(Tm1): 1.0000, 0.8000, 0.6767, 0.5724, 0.4842, 0.4096
p1(Tm2): 1.0000, 0.5724, 0.5265, 0.4842, 0.4453, 0.4096
p1(Tm3): 1.0000, 0.8698, 0.8000, 0.7358, 0.6767, 0.4096
p1(Tm4): 1.0000, 0.8698, 0.8000, 0.4842, 0.4453, 0.4096
p1(Tm5): 1.0000, 0.6490, 0.6224, 0.5969, 0.5724, 0.4096
The legend, *Time Column Id*, gives the sequence number of the measurement columns. Thus, 1.0 is Tm1, 2.0 is Tm2, and so on.

The pattern Tm4 consistently produces the highest power across all sample sizes. Remember that Tm4 put the measurements at the beginning and the end, but none in the middle.

Patterns Tm3 and Tm5 are nearly tied for achieving the lowest powers. Tm3 put most of the measurements at the beginning of the study. Tm5 put most of the measurements during the middle of the study.

Note that Tm1, the equally-spaced times, is in the middle of the pack.
Example 6 – Entering a Correlation Matrix

This example will show how a correlation matrix can be loaded directly.

In this example, M is 4, the standard deviation is 9.2, the TAD is 5, the significance level is 0.05, the sample size ranges from 50 to 500, and R is 50%. A correlation matrix (shown below) is available from a previous study. The missing input type will be set to Linear from 0 to 30% and the pairwise missing assumption is independent.

Table of Correlations

<table>
<thead>
<tr>
<th></th>
<th>C1</th>
<th>C2</th>
<th>C3</th>
<th>C4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.0000</td>
<td>0.7000</td>
<td>0.4900</td>
<td>0.3430</td>
<td></td>
</tr>
<tr>
<td>0.7000</td>
<td>1.0000</td>
<td>0.7000</td>
<td>0.4900</td>
<td></td>
</tr>
<tr>
<td>0.4900</td>
<td>0.7000</td>
<td>1.0000</td>
<td>0.7000</td>
<td></td>
</tr>
<tr>
<td>0.3430</td>
<td>0.4900</td>
<td>0.7000</td>
<td>1.0000</td>
<td></td>
</tr>
</tbody>
</table>

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the GEE Tests for the TAD of Two Groups in a Repeated Measures Design (Continuous Outcome) procedure window. You may then make the appropriate entries as listed below, or open Example 6 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td></td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N (Subjects)</td>
<td>50 80 110 140</td>
</tr>
<tr>
<td>R (Group 1 Allocation %)</td>
<td>50</td>
</tr>
<tr>
<td>Measurement Time Input Type</td>
<td>Equally Spaced Measurement Times</td>
</tr>
<tr>
<td>M (Number of Measurement Times)</td>
<td>4</td>
</tr>
<tr>
<td>δ (Time-Averaged Difference)</td>
<td>5</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>9.2</td>
</tr>
<tr>
<td>Pattern of ρ’s Across Time</td>
<td>Matrix on Spreadsheet</td>
</tr>
<tr>
<td>Columns Containing the ρjk’s</td>
<td>C1-C4</td>
</tr>
<tr>
<td>You must enter the correlation table using the Spreadsheet icon to the right.</td>
<td></td>
</tr>
<tr>
<td>Missing Input Type</td>
<td>Linear (Steady Change)</td>
</tr>
<tr>
<td>Pairwise Missing Pattern</td>
<td>Independent (Ind)</td>
</tr>
<tr>
<td>First Missing Proportion (Ind)</td>
<td>0</td>
</tr>
<tr>
<td>Last Missing Proportion (Ind)</td>
<td>0.30</td>
</tr>
</tbody>
</table>
Output

Click the Calculate button to perform the calculations and generate the following output.

Numeric Results for a Time-Averaged Difference Test using GEE
Measurement Times: Equally spaced
Correlation: Matrix stored on spreadsheet in columns C1-C4
Missing Pattern: Range of missing proportions
Observant Proportions: Assume independence

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>Alloct</th>
<th>Times</th>
<th>TAD</th>
<th>Std Dev</th>
<th>Base Corr</th>
<th>First Row of Corr</th>
<th>Alpha</th>
<th>Missing</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.6191</td>
<td>50</td>
<td>50.0</td>
<td>4</td>
<td>5.00</td>
<td>9.20</td>
<td>n/a</td>
<td>ρ1(T1)</td>
<td>0.050</td>
<td>M1(T1)</td>
<td>T1</td>
</tr>
<tr>
<td>0.8166</td>
<td>80</td>
<td>50.0</td>
<td>4</td>
<td>5.00</td>
<td>9.20</td>
<td>n/a</td>
<td>ρ1(T1)</td>
<td>0.050</td>
<td>M1(T1)</td>
<td>T1</td>
</tr>
<tr>
<td>0.9188</td>
<td>110</td>
<td>50.0</td>
<td>4</td>
<td>5.00</td>
<td>9.20</td>
<td>n/a</td>
<td>ρ1(T1)</td>
<td>0.050</td>
<td>M1(T1)</td>
<td>T1</td>
</tr>
<tr>
<td>0.9661</td>
<td>140</td>
<td>50.0</td>
<td>4</td>
<td>5.00</td>
<td>9.20</td>
<td>n/a</td>
<td>ρ1(T1)</td>
<td>0.050</td>
<td>M1(T1)</td>
<td>T1</td>
</tr>
</tbody>
</table>

Footnotes
T1: 0.0, 0.33, 0.67, 1.00
M1(T1): 0.00, 0.10, 0.20, 0.30
ρ1(T1): 1.0000, 0.7000, 0.4900, 0.3430

Pwr vs N

Autocorrelation Matrix for Report Row 1

<table>
<thead>
<tr>
<th>Time</th>
<th>T(0.00)</th>
<th>T(0.33)</th>
<th>T(0.67)</th>
<th>T(1.00)</th>
</tr>
</thead>
<tbody>
<tr>
<td>T(0.00)</td>
<td>1.0000</td>
<td>0.7000</td>
<td>0.4900</td>
<td>0.3430</td>
</tr>
<tr>
<td>T(0.33)</td>
<td>0.7000</td>
<td>1.0000</td>
<td>0.7000</td>
<td>0.4900</td>
</tr>
<tr>
<td>T(0.67)</td>
<td>0.4900</td>
<td>0.7000</td>
<td>1.0000</td>
<td>0.7000</td>
</tr>
<tr>
<td>T(1.00)</td>
<td>0.3430</td>
<td>0.4900</td>
<td>0.7000</td>
<td>1.0000</td>
</tr>
</tbody>
</table>

The standard reports are displayed.
Example 7 – Entering an Observant Probabilities Matrix

This example will show how an observant probabilities matrix can be loaded directly.

In this example, M is 4, the standard deviation is 9.2, the TAD is 5, the significance level is 0.05, the sample size ranges from 50 to 140, and R is 50%. The correlation pattern will be Linear Exponential Decay with a base correlation of 0.8, Base Time Proportion of 0.1, and Emax set to 4. The missing input type will be set to Matrix of Pairwise Missing.

Table of Observant Probabilities

<table>
<thead>
<tr>
<th>Row</th>
<th>C1</th>
<th>C2</th>
<th>C3</th>
<th>C4</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>1.00</td>
<td>0.90</td>
<td>0.80</td>
<td>0.70</td>
</tr>
<tr>
<td>2</td>
<td>0.90</td>
<td>0.90</td>
<td>0.72</td>
<td>0.63</td>
</tr>
<tr>
<td>3</td>
<td>0.80</td>
<td>0.72</td>
<td>0.80</td>
<td>0.56</td>
</tr>
<tr>
<td>4</td>
<td>0.70</td>
<td>0.63</td>
<td>0.56</td>
<td>0.70</td>
</tr>
</tbody>
</table>

This table gives the pairwise observant probabilities. That is, each entry gives the probability of obtaining a response for both the row and column time points. For example, 0.63 is the probability of observing both the second response and the fourth response.

Setup

This section presents the values of each of the parameters needed to run this example. First, from the PASS Home window, load the GEE Tests for the TAD of Two Groups in a Repeated Measures Design (Continuous Outcome) procedure window. You may then make the appropriate entries as listed below, or open Example 7 by going to the File menu and choosing Open Example Template.

<table>
<thead>
<tr>
<th>Option</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Tab</td>
<td>Power</td>
</tr>
<tr>
<td>Solve For</td>
<td>Power</td>
</tr>
<tr>
<td>Alternative Hypothesis</td>
<td>Two-Sided</td>
</tr>
<tr>
<td>Alpha</td>
<td>0.05</td>
</tr>
<tr>
<td>N (Subjects)</td>
<td>50 80 110 140</td>
</tr>
<tr>
<td>R (Group 1 Allocation %)</td>
<td>50</td>
</tr>
<tr>
<td>Measurement Time Input Type</td>
<td>Equally Spaced Measurement Times</td>
</tr>
<tr>
<td>M (Number of Measurement Times)</td>
<td>4</td>
</tr>
<tr>
<td>δ (Time-Averaged Difference)</td>
<td>5</td>
</tr>
<tr>
<td>σ (Standard Deviation)</td>
<td>9.2</td>
</tr>
<tr>
<td>Pattern of ρ’s Across Time</td>
<td>Linear Exponential Decay</td>
</tr>
<tr>
<td>ρ (Base Correlation)</td>
<td>0.8</td>
</tr>
<tr>
<td>Base Time Proportion</td>
<td>0.1</td>
</tr>
<tr>
<td>Emax (Max Decay Exponent)</td>
<td>4</td>
</tr>
<tr>
<td>Missing Input Type</td>
<td>Pairwise Observed Proportions on Spreadsheet</td>
</tr>
<tr>
<td>Columns of Pairwise Observed</td>
<td>C1-C4</td>
</tr>
</tbody>
</table>

You must enter the pairwise probabilities table using the Spreadsheet icon to the right.
Output

Click the Calculate button to perform the calculations and generate the following output.

### Numeric Results for a Time-Averaged Difference Test using GEE

Measurement Times: Equally spaced
Correlation: Linear exponential decay, with Emax = 4 and Base Time Prop = 0.1
Missing Pattern: N/A. Matrix of observant probabilities entered in columns C1-C4

<table>
<thead>
<tr>
<th>Power</th>
<th>N</th>
<th>Pct</th>
<th>Times</th>
<th>TAD</th>
<th>Std Dev</th>
<th>Base Corr</th>
<th>First Row of Corr</th>
<th>Matrix</th>
<th>Alpha</th>
<th>Missing</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.6153</td>
<td>50</td>
<td>50.0</td>
<td>4</td>
<td>5.00</td>
<td>9.20</td>
<td>0.8000</td>
<td>p1(T1)</td>
<td>0.050</td>
<td>n/a</td>
<td>T1</td>
<td></td>
</tr>
<tr>
<td>0.8133</td>
<td>80</td>
<td>50.0</td>
<td>4</td>
<td>5.00</td>
<td>9.20</td>
<td>0.8000</td>
<td>p1(T1)</td>
<td>0.050</td>
<td>n/a</td>
<td>T1</td>
<td></td>
</tr>
<tr>
<td>0.9165</td>
<td>110</td>
<td>50.0</td>
<td>4</td>
<td>5.00</td>
<td>9.20</td>
<td>0.8000</td>
<td>p1(T1)</td>
<td>0.050</td>
<td>n/a</td>
<td>T1</td>
<td></td>
</tr>
<tr>
<td>0.9649</td>
<td>140</td>
<td>50.0</td>
<td>4</td>
<td>5.00</td>
<td>9.20</td>
<td>0.8000</td>
<td>p1(T1)</td>
<td>0.050</td>
<td>n/a</td>
<td>T1</td>
<td></td>
</tr>
</tbody>
</table>

**Footnotes**

T1: 0.00, 0.33, 0.67, 1.00
p1(T1): 1.0000, 0.6725, 0.5249, 0.4096

The standard reports are displayed.